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TempView is a 16-bit graphical Microsoft Windows based application used to operate TempBook
hardware.  No programming knowledge is required to operate TempView.  The program allows you to set
up an application to acquire data, and save the acquired data directly to disk.  The program is featured with
the ability to transmit the data to other Windows applications, such as spreadsheets and databases.

TempView provides the following capabilities:

• Set up all of the analog input parameters, then acquire and save the data to a disk file.
• Exercise TempBook’s digital I/O section.
• Exercise the counter/timer.
• Launch 16-bit PostView, an independent application.  PostView provides a means of viewing

waveforms that were previously recorded by TempView.

Application Startup
If you have not already installed TempView, refer to chapter 1 of the TempBook/66 manual.

To launch the application, double-click the TempView icon.  TempView holds many user-configured
parameters that can be saved to disk.  The default configuration file name is “TEMPVIEW.CFG”.
TempView will then proceed to search the working directory for the TEMPVIEW.CFG configuration file.
The following conditions may apply:

• If the default configuration file is found, all the required setup information will be extracted from it,
and the application's main window will open.

• If the default configuration file is not found, TempView will try to connect with the TempBook
hardware with the following default parameters: Printer Port LPT1, Interrupt Level 7, and 4-bit
Standard Protocol.

• If connection with the TempBook is established, the applications main window will open with default
setup.

• If all of the above fails to establish communications with the TempBook, then a dialog box will appear
asking whether or not you want to open a different setup file.  Answering “Yes” will open another
dialog box where you can select your file.  If this is the first time you have used this application, no
saved setups will be available; select “No”.

• If a configuration file is selected, no further dialog boxes will appear, all the required setup
information will be extracted from it, and the applications main window will open.

• If no user configuration file is selected or found, or communications is not established, the next dialog
prompts the user to choose a real instrument or a simulated instrument.  If the hardware is not
available and you just want to try out the software, select Simulated Instrument.  The Simulated
Instrument mode allows you to exercise all the software functions without any hardware installed.  If
the TempBook hardware is connected and switched on, select Real Instrument.
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• If Real Instrument was selected, an additional dialog box will appear, prompting you to select the LPT
port that the hardware is connected to, the interrupt level of that port, and the parallel port protocol to
use.

TempView will attempt to find the TempBook on the specified LPT port.  If the hardware is found, the
application's main window will open.  If no hardware is found, a message appears and the application will
open with the controls disabled.

To reconfigure the LPT port setting and try again, click Select LPT Port under the Select Port menu.  If the
TempBook hardware still cannot be identified by the software, exit TempView and try the TEMPTEST
utility program.

TempView Components
The figure shows TempView’s main window that has areas for the following:

• Analog input spreadsheet to summarize system configuration and show current readings
• Trigger configuration, event type and edge
• Sequence repetition rate, number of scans, and averaging enable
• Data destination (filename and data format)
• High-speed digital input enable
• Signal reference type

TempView’s Main Window

Analog Input Spreadsheet
The input spreadsheet allows the analog input channels to be configured and displayed.  The spreadsheet
consists of rows and columns much like a standard accounting spreadsheet.

• Each row configures a single analog input channel.  There are 16 rows if single-ended inputs are
selected; or 8 rows if differential inputs are selected.

• The columns contain the configuration information for each channel.  Some columns allow blocks of
cells to be altered simultaneously while others allow only one cell to be changed at a time.  Clicking a
column header will select the entire column if possible.

The 7 columns for each row are used as follows:

CH - The channel-number column labeled "CH" is static and cannot be altered.  This column identifies rows
by the corresponding analog input channel to configure.
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ON - The column labeled "On" allows you to select whether or not data will be collected from the
corresponding input during an acquisition.  An acquisition consists of reading data to disk, either to charts
or the input reading column of this spreadsheet.  When a cell or block of cells in this column is selected, a
selection box will appear above the spreadsheet that allows a "Yes" or "No" choice to enable or disable the
channel.  Double-clicking a cell in this column will toggle the channel status.  The Make All Channels
Active and Make All Channels Inactive menu items under the Edit menu can be used to globally change all
channels to a "Yes" or "No".

Type - The "Type" column allows you to set the thermocouple or gain type for the selected channel or
block of channels.  Double-clicking a cell or block of cells in this column will select the next available gain
or type.

Pole - The "Pole" column shows the state of the channel polarity which can be either unipolar or bipolar.
The channel polarity can be programmed on a per channel basis.  If a cell or block of cells in this column is
selected, a selection box will be displayed above the spreadsheet with the selections "Uni" and "Bi" when
the cell is selected.  Double-clicking in one of these cells will toggle the polarity.

Label - The "Label" column contains a descriptive name for the input channel.  By default it contains a
label similar to its channel number; however, you can enter a more relevant, descriptive label of 8
characters.  This label will be used when selecting a specific channel in the analog trigger and chart
selection lists.  This column does not have a selection list above the spreadsheet and does not allow
selecting blocks of cells.

Units - The "Units" column allows you to change the
engineering units of each channel and apply a linear equation to
the data read from the TempBook.  When a cell or block of cells
in this column is selected, a selection box is displayed
containing mX+b as well as common engineering units (see
figure).  Selecting mX+b will pop up a window that allows the
m and b of this equation and the engineering units label to be
defined.  The engineering units will then be displayed in the
"Units" column, and the mX+b equation will be applied to the
reading from the TempBook before the reading is displayed or

written to disk.  The X in this equation is the voltage or the degrees in Celsius read back from the
TempBook.  For example, if a TempBook channel is configured as bipolar and unity (×1) gain, the default
voltage would be ±5 V.  This corresponds to an m of 1, a b of 0 and an engineering unit of V.  This could be
changed to millivolts by setting m to 1000 and units to mV.  This column could also be used to perform a
software calibration of the TempBook.  This is performed by reading known inputs at two different points
of the input voltage range (usually at 0 and full scale) and solving the equation y = mX+b.  The full-scale
voltage, which changes according to the gain of the channel, is 5V/gain for bipolar channels and 10V/gain
for unipolar channels.

Engineering Units Conversion Using mx + b
Most of our data acquisition products allow the user to convert a raw signal input (for example, one that is
in volts) to a value that is in engineering units (for example, pressure in psi).  The products accomplish this
by allowing the user to enter scale and offset numbers for each input channel, using the software associated
with the product.  Then the software uses these numbers to convert the raw signals into engineering units
using the following “mx + b” equation:

Engineering Units = m(Raw Signal) + b (1)

The user must, however, determine the proper values of scale (m) and offset (b) for the application in
question.  To do the calculation, the user needs to identify two known values: (1) the raw signal values, and
(2) the engineering units that correspond to the raw signal values.  After this, the scale and offset parameters
can be calculated by solving two equations for the two unknowns.  This method is made clear by the
following example.
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Example

An engineer has a pressure transducer that produces a voltage output of 10.5 volts when the measured
pressure is 3200 psi.  The same transducer produces an output of 0.5 volt when the pressure is 0 psi.
Knowing these facts, m and b are calculated as follows.

A - Write a pair of equations, representing the two known points:

3200 = m(10.5) + b (2)

      0 = m(0.5) + b (3)

B - Solve for m by first subtracting each element in equation (3) from equation (2):

3200 - 0 = m(10.5 – 0.5) + (b - b) (4)

Simplifying gives you:   

3200 = m(10) (5)

And so:

m = 320 (6)

C - Substitute the value for m into equation (3) to determine the value for b:

        0 = 320 (0.5) + b (7)

So:

 b = - 160 (8)

Now it is possible to rewrite the general equation (1) using the specific values for m and b that we just
determined:

Engineering Units = 320(Raw Signal) - 160 (9)

The user can then enter the values of m and b into the appropriate location using the facilities provided by
compatible data acquisition software, for example: DaqView, Personal DaqView, LogView, and
TempView.  The software uses equation (9) to calculate signal values in engineering units from that point
on.
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Reading - The "Reading" column can display the analog input readings of the TempBook.  This column
cannot be altered by the user and is enabled by selecting Enable Input Reading Column under the
Acquisition menu.  This column will update the readings as fast as the computer will allow.  If data is being
written to disk while this column is enabled, it will be updated whenever possible.  The spreadsheet cannot
be altered while the input reading column is enabled.

In addition to the analog inputs, there is one 8-bit digital input channel accessible on the termination card.
This high-speed digital input, which is read at the same rate as any analog inputs, can be enabled or disabled
by clicking the "ChanOn" checkbox in the lower right of the analog input spreadsheet.

Acquisition Configuration

The acquisition configuration section of TempView’s main window is just to the right of the analog input
spreadsheet.  This section has 5 parts: the Trigger, Scan Frequency, Number of Scans, Signal Conditioning,
and Data Destination sections.  These sections allow you to set up all of the acquisition parameters for the
analog inputs and the high-speed digital input channel.  The analog acquisition configuration includes
parameters for setting up a trigger source, the scanning frequency after the trigger is satisfied, the number of
scans to take after the trigger, and the file name for the collected data.  These settings will be used when an
acquisition-to-disk is started by selecting "Go" under the acquisition menu.

Trigger - The Trigger section selects the source of the trigger.  When the trigger is satisfied, the scans are
collected at the selected scan frequency and stored to disk.  The sources are: Key Hit, which arms the
acquisition and waits for the user to hit a key; and External TTL, which waits for a falling or rising edge on
the 'trig' input terminal on the termination card.

Sequence Rep Rate - The scan frequency can be set in units of seconds, minutes and hours.  Moving the
slide switch changes the rate.  The cursor can also be placed in the numeric field and a number can be
entered directly.  The maximum scan frequency is dependent on the number of channels that are enabled
and whether or not averaging is enabled.  Enabling more channels or enabling averaging will lower the
maximum scan frequency.

Signal Cond Averaging - The Averaging checkbox enables or disables averaging of the analog input data.
Averaging can be used to increase the effective accuracy of a noisy signal.  Averaging will increase the
actual scan frequency and number of scans, but the perceived scan frequency and number of scans (which is
set by TempView) does not change.

No. of Scans - The number of scans can range from 1 to 100,000.  A scan includes all of the channels that
are marked as "On" in the analog input configuration spreadsheet.

Data Destination - This section contains the file name and type of file(s) that exist after an acquisition-to-
disk is complete.  A file name can be typed in directly or the Browse Files button can be pressed to open a
file-selection dialog box.  The selected file will be placed directly into the filename field.  During an
acquisition, a raw binary file is created and updated as data is read.  After the acquisition is complete, an
ASCII text file and PostView binary file can be created if the appropriate checkbox is enabled.  Both of
these files can be read by PostView (described later in this chapter).  If the raw binary checkbox is not
enabled, the raw binary file will be deleted after creating the PostView or ASCII file.

After the acquisition is started, these parameters can not be altered.

Counter/Timer Window
The counter/timer window is displayed when ctr/tmr is selected under the Windows pull-down menu.  This
window allows configuration of the 8254's counter 0.  Counter 0 is configured by selecting its function,
clock source and initial count.  When the Start Timer button is clicked, the counter configuration will take
place.
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Counter/Timer Window

Digital I/O Window
The digital I/O window is displayed when digital I/O is selected
under the windows menu.  This window provides interactive control
of the 8 digital input lines and 8 digital output lines on the
TempBook termination card.  Select output values by clicking on the
output witches which toggle between 0 and 1—or you can enter the
hex value and <Enter>; the switch positions will update to reflect the
new setting.  When the Execute button is pressed, all output lines
will be updated and all input lines will be read.
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Charts and the Spreadsheet's "Reading" Column
Up to 4 charts can be displayed by selecting charts under the Window menu.  Before the charts can be
enabled, at least one chart must be assigned a channel through the channel’s drop-down list.  When a
channel is selected, you can change the minimum and maximum values displayed in the chart (see figure).
This can be done whether or not the charts are currently enabled.

The charts and the spreadsheet Readings column are independently enabled.  The charts can be enabled
under the Charts menu of the Charts window.  The Readings column can be enabled under the Acquisition
menu of the main TempView window.  These windows provide instant feedback of the analog input
readings.

Data is read and displayed in the charts and Readings column as fast as the computer will allow.  When an
acquisition to disk has begun using the Go command under the Acquisition menu, the charts and the
spreadsheet Reading column take a lower priority, updating only when there is sufficient time in the
acquisition-to-disk task.  Therefore, the data seen in the charts may not be an accurate reflection of the data
that is being placed on the disk.  As the scan rate is increased, the acquisition-to-disk task will take up more
processor time and the charts will be unable to keep up.

TempView Display Charts
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TempView Menu Items

File
The file menu provides four basic functions:

New Set all parameters to their startup setting.
Save Save the existing configuration for later recall.
Load Load a saved configuration.
Convert Binary to ASCII Convert a previously acquired binary file to an ASCII file that can be read by

spreadsheets or other analysis programs.
Convert Binary to PostView Binary Convert a previously acquired binary file to a binary file that can be read by

the PostView application.
Exit Leave the TempView program.

Edit
The Edit menu includes the following functions:

Make All Channels Inactive This command places a "No" in the On field of all of the channels.  If your channel
scan includes only a few channels, it may be easier to make all of the channels
inactive, then turn on only those few channels that you want.

Make All Channels Active This command places a "Yes" in the On field of all of the channels.
Fill Down When multiple cells within a column are selected, this command takes the top-

most selected cell and copies its contents in the selected cells below.

Select Device
The Select Device menu includes the following functions:

Select LPT Port Brings up a dialog box prompting the user to select the LPT port on which the TempBook is
connected.  After an LPT port is selected, TempView opens a new session with the
TempBook hardware and attempts to communicate with it.  If the hardware is found, the
main window is opened.  If no hardware is found, the user is alerted and the application is
opened with the controls disabled.  To reconfigure the LPT port setting and try again, click
Select LPT Port under the Select Port menu.  If the TempBook hardware still can not be
identified by the software, exit TempView and try the TEMPTEST utility program.

Simulated Device This command opens a TempView session but does not attempt to communicate with
TempBook hardware.  Instead, the application simulates the interaction between the
software and the hardware.  If TempView is presently attached to real TempBook
hardware, this command will close that session.

Window
The Window menu includes the following functions:

PostView This command launches an instance of the PostView application.
Charts This command displays the charts window.
Analog Output This command displays the analog output window.
Digital I/O This command displays the digital I/O window.
Ctr/Tmr This command displays the counter/timer window.

Acquisition
The Acquisition menu includes the following functions:

Go This command arms the hardware for an acquisition to disk.  When the trigger is satisfied,
the acquisition begins.  All of the interactive I/O controls are disabled while the system is
armed.  No acquisition parameters can be altered at this time.

Enable Input
Reading Column

This command reads the analog inputs and puts the numeric values in the spreadsheet in
the "Reading" column.  If it is already enabled, this command disables it.

Charts
The Charts menu of the charts window includes the following function:

Enable Charts This command starts the scroll chart running.  If the chart is already running, this command
stops it.
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